
GETTING STARTED GUIDE

http://www.americanmusical.com/Native-Instruments


The information in this document is subject to change without notice and does not represent a 
commitment on the part of Native Instruments GmbH. The software described by this document is 
subject to a License Agreement and may not be copied to other media. No part of this publication 
may be copied, reproduced or otherwise transmitted or recorded, for any purpose, without prior 
written permission by Native Instruments GmbH, hereinafter referred to as Native Instruments. All 
product and company names are ™ or ® trademarks of their respective owners.

Getting Started guide written by Alexander Stamm and Patryk Korman

Document Version: 1.0 (07/2009)

Product Version: 4.0 (07/2009)

Special thanks to the Beta Test Team, who were invaluable not just in tracking down bugs, but in 
making this a better product.

http://www.americanmusical.com/Native-Instruments


Germany

Native Instruments GmbH

Schlesische Str. 28

D-10997 Berlin

Germany

info@native-instruments.de

www.native-instruments.de 

USA

Native Instruments North America, Inc.

5631 Hollywood Boulevard

Los Angeles, CA 90028

USA

sales@native-instruments.com

www.native-instruments.com

© Native Instruments GmbH, 2009. All rights reserved.

http://www.americanmusical.com/Native-Instruments


GETTING STARTED – IV  

Table Of Content

1. Welcome to GUITAR RIG 4 ....................................................................................................5

1.1 What is GUITAR RIG 4? ...............................................................................................6

1.2 What’s new in GUITAR RIG 4? ...................................................................................6

2. Things You Should Know ...................................................................................................7

2.1 For Your Protection .................................................................................................7

2.2 About Real-Time Audio Processing ...........................................................................7

2.3 GUITAR RIG 4 Usage Modes .....................................................................................8
2.3.1 Stand-Alone Mode ............................................................................ 8
2.3.2 Plug-in Mode ................................................................................... 8

3. The First Session with GUITAR RIG 4 ..................................................................................9

3.1 Starting GUITAR RIG 4 for the First Time ...................................................................9

3.2 User Interface (Overview) ......................................................................................10
3.2.1 Global Header .................................................................................10
3.2.2 Main Area .......................................................................................11
3.2.3 Toolbar and Rack .............................................................................13
3.2.4 Virtual Rig Kontrol ............................................................................13
3.2.5 SideKick ........................................................................................ 14

3.3 Using the Rack Tools .............................................................................................15

3.4 Building a Rack from Scratch .................................................................................17
3.4.1 Setting Up an Amp ..........................................................................19

3.5 Controlling Parameters with the Rig Kontrol ...........................................................21

3.6 Working with Presets ............................................................................................22
3.6.1 The Preset Browser ......................................................................... 23
3.6.2 How to Create Tags ......................................................................... 25
3.6.3 Using Component Presets ................................................................ 27

4. What’s Next? ..................................................................................................................29

http://www.americanmusical.com/Native-Instruments


GETTING STARTED – 5

1. Welcome to GUITAR RIG 4
Thank you for purchasing GUITAR RIG 4. We hope you enjoy using this product as much 
as we did creating it!

This Getting Started guide provides you with the essential information needed to use 
GUITAR RIG 4 and explains how to accomplish fundamental tasks.

The following documents are also available:

 ► The Setup Guide tells you how to install, activate and configure GUITAR RIG 4 on 
your system.

 ► If you want to dig deeper into GUITAR RIG 4 and its possibilities, check out the 
GUITAR RIG 4 Application Reference. It explains every function of the platform in 
greater detail.

 ► To learn about each and every knob that controls the amps, distortion pedals and 
other components for shaping and modulating GUITAR RIG’S sounds, refer to the 
Components Reference.

 ► If you have obtained GUITAR RIG 4 in a hardware bundle (MOBILE/SESSION/
KONTROL), please read the according Hardware Reference to correctly set up your 
hardware and software.

All manuals can be accessed through the program menu by selecting Help > Open Manual 
> Your Language.

You can also visit the community forums at native-instruments.com/forum where 
beginners and experienced users exchange knowledge on Native Instruments  
products every day.

But now let’s get going…

SPRACHE IN Paragraph-Style “05 - STANDARD Fließtext” passend einstellen

http://www.native-instruments.com/forum/
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1.1 What is GUITAR RIG 4?

GUITAR RIG 4 is a really powerful software for creating guitar and bass tones, as well 
as complex effect chains for virtually any musical purpose.

It is like a room filled with legendary amplifiers, endless arrays of cabinets, each with 
different microphones, any effect you desire, a loop machine and other amazing tools for 
crafting sounds at your immediate disposal.

GUITAR RIG 4 comes in four different editions: GO, LE, ESSENTIAL and PRO – differing 
in the number of included components. But no matter which version your GUITAR RIG 
4 platform came in, you can easily load it up with COMPONENT PACKS, expanding the 
selection of amps and effects with coveted, ultra-rare models. Additional GUITAR RIG 4 
COMPONENT PACKS will be released regularly in future.

1.2 What’s new in GUITAR RIG 4?

GUITAR RIG 4 implements a multitude of improvements to the software. Here is what’s 
new in comparison to older versions:

 ► New, exciting components (in the Pro edition): Top Lead, Hot Plex, Control Room, 
Grain Delay, Octaverb, Iceverb, Twin Delay

 ► Improved, even more intuitive user interface

 ► Improved, tag-based Preset Browser

 ► Improved workflow for component presets

 ► Enhanced amp sound

 ► Reworked controls for time-based effects modules

 ► Improved sound for pitch-based effects

 ► New cabinet technology

 ► True stereo processing (optional for CPU-intense components)

 ► New controller assignment concept

 ► MIDI controller support for Rig Kontrol 2/3

 ► Dynamic host automation parameter list

http://www.americanmusical.com/Native-Instruments
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2. Things You Should Know
This chapter will shed light on some fundamental aspects of using GUITAR RIG 4 for 
music production and performance.

2.1 For Your Protection

GUITAR RIG 4 – in combination with headphones or amplifier-driven speakers – can 
produce sounds in decibel ranges that may cause hearing damage. For your protection, 
set all volume levels to a minimum before using GUITAR RIG 4. Gradually raise the 
volume controls while music is playing to set the desired listening level. If you experience 
any hearing problems or persistent ringing in the ears, consult an audiologist immediately.

2.2 About Real-Time Audio Processing

Real-time audio processing – like recording a guitar with GUITAR RIG 4 live into your 
PC – requires an audio device to convert the analog signal into digital data in a very short 
time. On-board audio devices of most Windows machines are usually not suitable for the 
task, because their drivers are not optimized for fast signal processing. The result is an 
audible delay from the moment you play a note on your instrument until you hear the  
output from your speakers. This delay is measured in milliseconds and called latency.

We recommend using an audio device designed specifically for audio production  
applications such as the audio interfaces of the GUITAR RIG family (GUITAR RIG MOBILE 
I/O, SESSION I/O, RIG KONTROL). They keep latency at an unperceivable minimum level 
while providing you with professional sound and a stable performance. 

http://www.americanmusical.com/Native-Instruments
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If a professional audio device is out of reach for you at the moment, you could also use a 
third party  ASIO audio device driver for your audio device. This freeware tool can make 
the audio processing capabilities of a conventional on-board audio device sufficient for 
real-time audio processing.

ASIO sound device drivers such as ASIO4ALL are available for free on the internet.

Apple computers are equipped with a relatively powerful audio system straight away, but 
there may still be sound quality issues with on-board audio.

2.3 GUITAR RIG 4 Usage Modes

There are two basic operation modes of GUITAR RIG 4:

 ► In Stand-alone mode GUITAR RIG 4 will work independently of any other software. 

 ► In Plug-in mode GUITAR RIG 4 will run as plug-in of a host application.

2.3.1 Stand-Alone Mode
As a Stand-alone application, GUITAR RIG 4 turns your computer into a ready to use 
guitar rack all by itself – build presets, practice to backing tracks, record ideas or play 
gigs without needing anything else.

2.3.2 Plug-in Mode 
In Plug-in mode, GUITAR RIG 4 is hosted by a DAW (digital audio workstation). It supports 
VST / RTAS / AU compatible DAWs such as GarageBand, Cubase, Logic, Pro Tools, Live, 
Sonar etc. It can work as an insert and as an FX plug-in.

During installation on a Windows computer, you need to specify the folder where your DAW 
looks for VST plug-ins. You can move the plug-in file called “Guitar Rig 4.dll” at anytime 
in case you changed your plug-in folder or made a mistake.

http://www.americanmusical.com/Native-Instruments
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3. The First Session with GUITAR RIG 4
Make sure that GUITAR RIG 4 and your audio device are set up correctly before 
proceeding – see the Setup Guide to learn how! 

During this session, we will use the Stand-alone mode of GUITAR RIG 4. However, the 
basic operation is quite similar in both modes so you will be able to follow the instructions 
whether you use it in Plug-in mode or Stand-alone mode.

3.1 Starting GUITAR RIG 4 for the First Time

 ► Start the application by double-clicking the  shortcut on your desktop. Alternatively 
you can double-click the program file in the installation folder.

Starting GUITAR RIG 4 for the First Time, you will have to select your audio device from 
the “Audio and MIDI Settings…” window. This applies to Stand-alone mode only, as the 
sound output in Plug-in mode is managed by the host application.

To select or change your audio device at a later stage:

1. Open the “File” menu (on Windows XP/Vista) or respectively the “Guitar Rig 4”  
menu (on Mac OS X).

2. Go to “Audio and MIDI Settings…”

3. Select your audio device and driver from the relevant drop-down menus.

4. Click Ok to confirm.

http://www.americanmusical.com/Native-Instruments
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3.2 User Interface (Overview)

Learn about the areas and elements of the user interface in this section.

3.2.1 Global Header
The Global Header holds the most important controls. It is always visible in GUITAR RIG 4.

This element might not seem that interesting at first glance but understanding the Global 
Header is crucial for working with GUITAR RIG 4. In and Out are the input and output 
meters, featuring an integrated volume fader to control input and output amplification.

 ► The L/R buttons control the input routing. When using a guitar, deactivate the right 
channel (by clicking on R once) to route the mono signal to both stereo inputs. 

 ► The   button (de-)activates the Limiter to prevent the output level from reaching 
harmful volume peaks.

 ► The  button controls a basic noise gate, killing the hiss while you are not playing. 
Turn it on and off by clicking on the button, and adjust the threshold with the knob. 
Double-click the knob to activate a learn function – do not play for some seconds, and 
the threshold will be set automatically.

http://www.americanmusical.com/Native-Instruments
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3.2.2 Main Area
Beneath the Global Header there is the Main Area. It offers two different basic viewing modes:

 ► Standard view

 ► Live view

The Standard view

In Standard view, GUITAR RIG 4 is a laboratory giving you all the options to build and 
organize your presets. Stack up and combine the countless effect units, prepare live gigs, 
record tracks or experiment with effect chains to shape unheard sounds.

http://www.americanmusical.com/Native-Instruments
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Click the  button, or hit F1 to switch between the Live View and the Standard View. 
The Live view hides all the sound creation tools, but puts the most important performance 
features into a clear layout – perfect for on-stage use.

The Live view

http://www.americanmusical.com/Native-Instruments
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3.2.3 Toolbar and Rack
Go to Standard view by clicking the  button again. In Standard view, the Rack is on 
the right hand side of the screen. Note the Toolbar on top of it: 

This is your one-stop-shop to access the Virtual Rig Kontrol, the Rack Tools and some 
handy features. Press the buttons to see what each of them does!

The Rack itself holds all components processing your sound giving a clear overview of the 
signal flow. It is the heart of GUITAR RIG 4’s functionality. Go to section 3.4 to learn how 
to fill it with your content of choice!

3.2.4 Virtual Rig Kontrol
On bottom of the Rack, there is the Virtual Rig Kontrol. Click the   button in the toolbar 
or press F3 to show/hide it. The Virtual Rig Kontrol is the graphical representation of the 
RIG KONTROL foot controller. It conveniently shows which functions are assigned to the RIG 
KONTROL’s buttons and foot pedal. Even if you are not using the physical RIG KONTROL, 
you can assign any external controller to the Virtual Rig Kontrol to benefit from its graphical 
representation, especially in Live view. Refer to the Application Reference for details.

The Virtual Rig Kontrol

http://www.americanmusical.com/Native-Instruments
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3.2.5 SideKick
The SideKick is a multifunctional area that displays different content depending on which 
of the tab buttons  (BROwseR, COmpOnents or OptiOns) is activated. It is not necessary at all 
times and can be hidden by clicking the  button next to the tab buttons or by pressing F2.

The SideKick in its three viewing modes.

 ► Click on BROwseR to open the Preset Browser in the SideKick. You can organize your 
presets and perform a text- or tag-based search to easily find your presets.

 ► Click on COmpOnents to open the Components Pool. It contains all available components 
along with their presets. You can simply drag components from here and drop them into 
the Rack. Refer to the Components Reference for detailed information on each of them.

 ► Click on OptiOns to open the Options Menu. It serves to configure external controllers 
and their assignments, preferences such as the window height and other details. Refer 
to the Application Reference for more details.

http://www.americanmusical.com/Native-Instruments
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3.3 Using the Rack Tools

Tapedeck Pre and Post

Both tapedecks basically work the same way, and very similar to the ones you may still 
know from physical racks. Yet, due to their fixed position as first (Pre) or last (Post) com-
ponent in the Rack, they are performing different functions.

 ► Tapedeck Pre is for playing back and recording audio at the beginning of GUITAR RIG’s 
signal chain (except when play at Output is activated). It will pick up the dry, 
unprocessed signal.

 ► Playback in Tapedeck Pre will send it through all modules currently in the RaCk. This 
enables you to keep an unprocessed version of the signal in Tapedeck Pre.

 ► Tapedeck Post is for playing back and recording audio at the end of GUITAR RIG’s 
signal chain. Recording your guitar will pick up the processed signal, just as you  
hear it at the output.

 ► Use Tapedeck Post if you want to record your guitar part with the actual sound, e.g. 
if you want to export a track to another program.

 ► When synC is activated, Tapedeck Post starts and stops simultaneously with Tapedeck Pre.

 ► To save a recorded file, just click on the  button and select a name and location.

http://www.americanmusical.com/Native-Instruments
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Tuner

The Tuner not only helps you to keep the standard tuning, but also offers some common 
tunings you can select from the dropdown menu on its left hand side.

 ► The   buttons allow switching between two alternative display modes.

 ► The  button is doing what it says and especially convenient when using the tuner live.

Metronome

The Metronome is for keeping yourself in time, and also serves as the clock for all 
synchronized rack modules, such as modulation and delay effects. 

 ► You can dial in any tempo between 20 and 400 beats per minute. Click on the Bpm 
display and drag up or down to change its value, or double-click it to enter a  
numerical value straight away.

 ► Another way to set the tempo is to click on the  button repeatedly. The Metronome 
will determine your average speed and set the Bpm control accordingly.

 ► You can choose different time signatures using the dropdown menu in the signat. display.

The Sync setting defines if the Metronome obtains its tempo setting from any other source. 
The three available sync settings are:

 ► Exit: The Metronome is synchronized to an external tempo via MIDI.

 ► Sound: The current tempo is saved and loaded with the Rack Preset.

 ► Free: The Metronome can run freely at the tempo you set.
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3.4 Building a Rack from Scratch

Before starting, please refer to the Setup Guide to connect your instruments, hardware 
and software correctly.

On the first start, the Rack is empty. You will hear a dry, amplified guitar sound when you 
play: perfect time to try out the various components. On future starts, the software will 
always retain the Rack’s last state. Click on  in the Toolbar to empty the Rack.

http://www.americanmusical.com/Native-Instruments
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The Components Pool

Open the Components Pool by clicking on COmpOnents in the SideKick’s Tab Button bar. It 
contains all sound-shaping and modulating components and component presets ordered 
by 8 categories. Click on the respective header below the Tab Button bar to get to the 
content listed below.

http://www.americanmusical.com/Native-Instruments
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 ► amps: Guitar and bass amps, cabinets

 ► Dist: Distortion, Overdrive and Fuzz pedals

 ► mOD: Time- and pitch-based modulation effects and synthesizers (Flanger, Octaver, etc.)

 ► eQ: Equalizers, filters and wah-wah pedals

 ► VOl: Volume-based effects (Compressor, Noise Gate, etc.)

 ► ReV: Reverbs and Delays

 ► tOOls: Loop Machine and tools for parallel signal processing

 ► mDF: Modifiers allowing for elaborate parameter modulation of other components

When you select any component by clicking on it, a list of all available component presets 
is shown below.

To view additional information on a particular component, click on the  button on 
the bottom of the SideKick.

3.4.1 Setting Up an Amp
A common start for designing sounds with GUITAR RIG 4 is adding an amp to the Rack. 
If you want to create a guitar sound, try the Lead 800:

 ► Double-click on the amp’s icon in the Components Pool to quickly add it to the Rack.

 ► The amp and a Matched Cabinet will simultaneously be added to the RaCk. If you play 
now, you will hear the famous Plexi sound (or rather a tastefully gain-spiced version of it).

All the knobs and switches you see are actually controlling the amp’s sound. Clicking with 
the mouse flips the switches, clicking and dragging the mouse up and down (while holding 
the mouse button down) turns the knobs. 
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If you want to check out some amp settings prepared by our sound designers, try  
component presets to configure the Lead 800.

 ► Click on the Component Preset box ( ) of the amp. The component should 
be highlighted in orange both in the Rack and in the Components Pool now.

 ► Double-click one of the Component Presets listed below in the Components  
Pool to load it.

Basics of Rack-Building
Now you can tweak the amp yourself, add distortion modules, modulating effects or try 
out whatever you please. But before, there are a few more basic principles to know:

 ► The audio signal runs through the chain of rack modules from top to bottom, except 
if you are using special tools that create parallel processing paths (like the Split).

 ► You can add components to the Rack by dragging them from the Components Pool 
and dropping them into any position you want. You can also add the component  
pre-configured to a particular sound by dragging a component preset into the Rack

 ► Selected rack modules will be replaced if you double-click on another component in the 
COmpOnents pOOl (or another component preset will be loaded, respectively). If no rack 
module is highlighted, double-clicking will add the component to the end of the rack.

 ► You can remove components from the rack by highlighting them and pressing DEL or 
by dragging and dropping them anywhere outside of the rack.

 ► All modules in the rack feature a small column on the right: The  button allows for 
true bypassing of the module. The  button minimizes the module’s display. The  
toggles its expert panel, if available.
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3.5 Controlling Parameters with the Rig Kontrol

If you are using GUITAR RIG KONTROL, controlling GUITAR RIG 4 with the included RIG 
KONTROL foot pedal is child’s play. For details on controller assignments and how to 
use other controllers, please consult the Application Reference. Make sure that your RIG 
KONTROL is connected via USB 2.0 and activate the Virtual Rig Kontrol by clicking its 

 button in the Toolbar.

 ► On the ViRtual Rig kOntROl, each button is headed with an LED indicating its status 
(on/off). The LED bar left of the foot pedal shows the degree to which it is pressed 
down. The buttons, as well as the foot pedal, can also be operated with the mouse.

 ► The labels below the buttons and left of the foot pedal precisely show which function 
is currently assigned to them. You can drag and drop them to various controls to  
assign functions such as play or record to them.

 ► The buttons of the RIG KONTROL are best suited for controlling On/OFF switches of 
rack modules and the likes, whereas the pedal is perfect for continuous parameters 
like the wah-wah slider or volume.
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3.6 Working with Presets

The tag-based Preset Browser and a powerful search function make navigating and  
managing presets easy. Component Presets allow for a modular approach to preset building.

At this point, it is important to understand the two different kinds of presets in GUITAR RIG 4:

Rack Presets
Rack Presets allow you to store and recall complete Rack setups and organize them in 
a convenient way. Each Rack Preset consists of a chain of components with their exact. 
GUITAR RIG 4 ships with a huge amount of Rack Presets of any style, and you can easily 
create your own ones.

Component Presets
A Component Preset contains all settings for one single component, e.g. the knob positions 
of an amp. After highlighting one of the items in the Components Pool, all its available 
presets are shown in a list below.
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3.6.1 The Preset Browser
In the SideKick, click on the BROwseR button to open the Preset Browser.

The Preset Browser
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 ► Three columns with Preset Attributes (also referred to as tags) define which presets 
are shown in the pReset list below.

 ► If no tag is highlighted (orange), all available presets are shown.

 ► A text-based search bar sits on top of the pReset list, pROViDing a quick way to find a 
particular preset in the current list by name.

 ► You can sort the pReset list by list numBeR, name anD Rating.

 ► The Rating is very helpful for keeping order in your growing archive: Give each preset 
a quality rating by clicking on one of the 5 dots in the line of its name.

 ► The buttons on the bottom of the siDekiCk allow for saving presets, and for switching 
to the inFO page of a preset.

Saving Rack Presets
 ► Pressing the saVe button will make any changes to the currently loaded preset permanent.

 ► Pressing the saVe as button will open the Save Page to create a new preset. It will 
automatically be tagged with the currently highlighted Preset Attributes.

 ► You can still change these, as well as entering additional information for the preset, 
before confirming by clicking on saVe.

Using Tags on Three Levels
The tags in the Preset Attributes list are hierarchic, detailing a category or description from 
left to right. This is useful when searching for presets. Each tag of the first and second 
level can contain sub-tags that allow you to further narrow down what you are looking 
for. For example, the tag “Guitar Styles” (1st column) could contain a “Rock” tag (2nd 
column). The tag “Rock” could contain “80s Punk Heros” (3rd column) – among others.

You can create and relate tags to bring your presets into the structure that fits your needs 
best. As each preset can appear under multiple tags of different levels, you have a lot of 
organizational power at hand. 
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3.6.2 How to Create Tags
Let us create an exemplary three-level tag for presets you want to use on stage with your 
band. The levels could read something like this: “My Presets – The Band – Live”:

1. Create a new tag. Right-click in the first column, select Create a new tag (or simply 
double-click on an empty field). Type in a text label (“My Presets”) and press Enter.

2. Click on the newly created tag to select it – it must be highlighted. Double-click into 
the middle column and create a new tag (“The Band”). This is your first sub-tag. 

3. Creating a sub-tag on the third level works exactly the same way, just highlight “The 
Band” and create a new tag called “Live” in the right-most column.
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Tagging Presets
Adding tags to presets works with drag and drop: Just click on one of the presets in the 
Preset list and drag it onto one of the tags in the left column of the Preset Browser.

The preset will now be listed both under the tag that was activated before you dragged it, 
and under the new tag. To delete a tag, just delete the preset from the according list – no 
worries, the preset itself is not deleted by this action!
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3.6.3 Using Component Presets
GUITAR RIG 4 comes with plenty of factory presets for components. They are a time-saving 
alternative to adjusting sound manually for each component. After selecting an item of the 
Component Pool, a list of all available Component Presets is displayed in the lower part 
of the SideKick.

Double-clicking the Component Preset in the list has the same effect as double-clicking 
the basic component in the Component Browser:

 ► If no rack module is highlighted, the component will be added to the end of the rack 
with the stored settings.

 ► If a different component is highlighted, it will be replaced with the new, adjusted 
component.

 ► If the same component is highlighted in the rack, its settings will be updated with the 
component preset. This is useful if you quickly want to check out different settings of 
a component in the context of your current rack.
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You can even drag and drop a Component Preset anywhere into the Rack!

Once you have found a “perfect setting” for components you use regularly, you can save 
your own Component Preset. Click on the triangular arrow right of the Component Preset 
Display (left on each rack module) and select Save As. This will create a new entry in the 
according list of Component Presets. Type in a name and press Enter.
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4. What’s Next?
Congratulations, you now know about the most important functions of GUITAR RIG 4. For 
further steps in exploring the software, we recommend both reference manuals, depending 
on your individual learning goal:

 ► The Application Reference deepens the aspects touched in this short introduction and 
should leave no question unanswered. It is the place to go if you want to learn how to 
control the software via MIDI (section 8.1), how to fully exploit the Preset Browser 
(section 3.1), but also how to realize overdub recordings using the Tapedecks (section 
5.2.2), and much more!

 ► The Components Reference introduces all of GUITAR RIG 4’s components, explaining 
all their parameters and the way they treat the sound. This is your next stop if you 
want to quickly build your own Racks, exactly understanding what each module  
can do for you.

 ► Regardless where you go from here, have fun and success using GUITAR RIG 4 – make 
it your tool for perfect custom tone.
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